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Chapter 1. IBM Tivoli Workload Scheduler for Applications,
Version 8.1.1 Readme File for Fix Pack 3 (PTF U499054)

Date 30 November 2004

Fix Pack
8.1.1-TIV-TWSWSE-FP0003

PTF Number
U499054

Product
IBM Tivoli Workload Scheduler for Applications, Version 8.1.1

General Description
IBM Tivoli Workload Scheduler for Applications, Version 8.1.1 Fix Pack 3

This readme file provides important information about Fix Pack 3 (PTF U499054)
for IBM Tivoli Workload Scheduler for Applications, Version 8.1.1. This readme file
is the most current information for the fix pack and takes precedence over all other
documentation for IBM Tivoli Workload Scheduler for Applications, Version 8.1.1.
This fix pack fixes a variety of defects on the following access methods:

* Oracle E-business Suite

* PeopleSoft

* R/3

Note: R/3 access method has not been updated since Fix Pack 2
* z/0S

Please review this section thoroughly before installing or using this fix pack.

About this release

This section includes the following topics:

* |"Fix pack structure” on page 2|

« |“Features introduced with Fix Pack 2” on page 2|

* |”APARs and defects fixed in IBM Tivoli Workload Scheduler for Applications|
Version 8.1.1 fix pack 3” on page 3|

* |”APARs and defects fixed in IBM Tivoli Workload Scheduler for Applications
Version 8.1.1 fix pack 2” on page 4|

* |”APARs and defects fixed in IBM Tivoli Workload Scheduler for Applications
Version 8.1.1 fix pack 1” on page 5

* |“Installation” on page 6

+ [“Hardware and software requirements” on page 6

« |“Applying the Fix Pack” on page 6|

* |“Notes for the User” on page 8

* [“Documentation Problems and Corrections” on page 18|

© Copyright IBM Corp. 2003, 2004 1



Fix pack structure

IBM Tivoli Workload Scheduler for Applications, Version 8.1.1 Fix Pack 3 has the
following structure:

/
8.1.1-TIV-TWSWSE-FPOOO3.README (this file)
8.1.1-TIV-TWSWSE-FPAB3. VSR

+---MCMAGENT_AIX
ORACLE.TAR
+---MCMAGENT_HPUX
ORACLE.TAR
+---MCMAGENT_SOLARIS
ORACLE. TAR
+---MVS_AIX
MVS.TAR
+---MVS_HPUX
MVS . TAR
+---MVS_I386NT
MVS.TAR
+---MVS_IRIX
MVS.TAR
+---MVS_OSF
MVS. TAR

+---MVS_SOLARIS
MVS.TAR

+---PSAGENT_I386NT
setup.exe

+---R3BATCH_AIX
R3BATCH.TAR

+---R3BATCH_HPUX
R3BATCH.TAR

+---R3BATCH_I386NT
r3batch.zip

+---R3BATCH_OSF
R3BATCH.TAR

+---R3BATCH_SOLARIS
R3BATCH.TAR

\---205
LOADLIB_811_FP3

Features introduced with Fix Pack 2

The following features have been introduced with fix pack 2 for PeopleSoft:
Internal CMVC Feature: 11128
The Fix Pack provides the ability to use the data already present in the database to

resolve in-line bind variable values by taking data from the database and
substituting it with variable definitions. It then allows job submission regardless of
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the use of in-line variable definitions in the jobs. The submission activity from the
Tivoli Workload Scheduler perspective does not depend on the types of jobs that
are being submitted. There are limitations, when the data used for PeopleSoft jobs
is volatile (never stored in the database).

In these cases the data ends its life when a PeopleSoft GUI transaction is complete.
When these types of process are used, the "runcontrol data record” is referred to as
the "Work record”. The resolution of the work record data used in in-line bind
variables is not possible, as it is for other kinds of control records, and requires
special management. This case is currently out of the scope of this fix pack.

When you submit Tivoli Workload Scheduler using a process that has in line bind
variables, the process type in the PeopleSoft GUI will be called ITWS_<process
type> For example, ITWS_Crystal instead of Crystal.

APARs and defects fixed in IBM Tivoli Workload Scheduler for
Applications, Version 8.1.1 fix pack 3

This section lists the APARs and defects fixed in IBM Tivoli Workload Scheduler
for Applications, Version 8.1.1 Fix Pack 3 by access methods. It is divided into the

following sub-sections:
° /IZ / OS’

* [“Oracle Applications”|
+ |[“PeopleSoft” on page 4|

z/0S

The following APARs and Defects were fixed for z/OS:

* APAR PQ92957: Jes job ended with RC=0 incorrectly reported to TWS as User
Abend value is higher than the maximum allowed.

* APAR PQ83225: z/OS access method not recognized event ID 2004 as an abend
for submitted QJ requests.

* APAR PQ77450: Error in routing of module TSITCPL? as modified by fix F12

¢ APAR PQ89268: CheckInterval not taken into account when receiving ‘9" as QJR

¢ APAR PQ95242: CA-7 ignores command if TSSERVER is sending them too close
together in time.

* APAR PQ97437: MVSCA?7 - Invalid transaction syntax when '9” is returned after
alJ

¢ Internal CMVC Defect 12037: Garbage in the transaction buffer sent to the
Gateway

* Internal CMVC Defect 13238: Q] is sent when checking an ext dep on an OPC
Application

e Internal CMVC Defect 13342: mvsca7 - INVALID TRANS SYNT when ’9’ is
returned after a L]

Oracle Applications
The following APARs and Defects were fixed for Oracle Applications:

* APAR IY53985: Problem when the encrypted password generated by enigma has
shell control characters.

¢ Internal CMVC Defect 11547: No tag added in mcmoptions to require the oracle
db instance

* Internal CMVC Defect 13393: If .profile of user has "!/bin/ksh’ then "sh
mcminstall” fails
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* Internal CMVC Defect 13395: MCMAGENT search mcmoptions file under home
of job user

* Internal CMVC Defect 13391: MCMAGENT doesn’t work in 3-tier connectivity

PeopleSoft

The following APARs and Defects were fixed for PeopleSoft:

¢ APAR IY52805: Job cancelled in PeopleSoft does not cancel in TWS correctly.
* APAR IY58262: PeopleTools version 8.44 is not supported

* Internal CMVC Defect 11751: Process and process type exchanged if processtype
is wrong

 Internal CMVC Defect 11962: On win2K, if classpath has a short size, psagent
traps

* Internal CMVC Defect 11975: nVisionReport Process recreated,if stop start the
Appl Server

* Internal CMVC Defect 13353: If Path has a short size the psagent traps

APARs and defects fixed in IBM Tivoli Workload Scheduler for
Applications, Version 8.1.1 fix pack 2

This section lists the APARs and defects fixed in IBM Tivoli Workload Scheduler
for Applications, Version 8.1.1 Fix Pack 2 by access methods. It is divided into the
following sub-sections:

* [“Oracle Applications”|

. ['R/37
. ['z/08”
Oracle Applications

Internal CMVC Defect 11255: In OraApps 3-tier connect parm is taken as part of
password.

R/3
APAR 1Y39442: SAP jobs created via the JSC abend when run.

Internal CMVC Defect 11057: Incorrect message prompted when installing r3batch
on UNIX.

z2/0S
Distributed

Internal CMVC Defect 10278: Event number 2004 is treated incorrectly.

Internal CMVC Defect 11124: Events 2003, 2007, and 2008 are mapped onto
ABEND.

Mainframe
APAR PQ74695: Awaiting hardcopy not accepted as complete by TSSERVER.

APAR PQ78332: MVS X-Agent does not recognize JCL errors on the mainframe.
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APARs and defects fixed in IBM Tivoli Workload Scheduler for
Applications, Version 8.1.1 fix pack 1

This section lists the APARs and defects fixed in IBM Tivoli Workload Scheduler
for Applications, Version 8.1.1 Fix Pack 1. It is divided into the following
sub-sections:

* |“Oracle Applications”|

* [“PeopleSoft”

* [“"R/3"

* [“z/0OS”

Oracle Applications
APAR 1Y42944: MCMAGENT generating error - Application or responsibility not
proper, error when ARGS are correct.

PeopleSoft
Internal CMVC Defect 151326: After PSOFT 8.4 job submission, job messages in
JOBLOG are not correctly displayed.

Internal CMVC Defect 151471: No messages in JOBLOG with PS84x if JVMPATH
not specified.

Internal CMVC Defect 153213: False abend with return code 259 when TVPUPSFT
closes abnormally

Internal CMVC Defect 154847: Backend retry interval wrongly set to 3

Internal CMVC Defect 157152: Output control keyword for folder not implemented
in PSAGENT 8

R/3
APAR 1Y39433: ABAP Program name is truncated to 8 characters. Job abends.

APAR 1Y39501: R3BATCH occupied high percentage of CPU on windows FTA
when attempting to edit existing jobs.

APAR 1Y41886: SAP jobs via R3BATCH not synchronizing to free batch processes
on SAP not synchronizing to free batch processes on SAP applications servers.

APAR 1Y41089: R3BATCH jobs that use the BDC and RUN a long time finished
with abend.

APAR 1Y39112: SAP 4.0B and TWS 8.1.1 SAP XA R3BATCH. ABAP program name
is truncated to 8 CHARS. Job abends.

Internal CMVC Defect 10276: R3BATCH Usable to use different clients with -client
option

Internal CMVC Defect 10740: SAP has changed the logic for the function module
RFC_ABAP_INSTALL_AND_RUN and is going to dismiss this function in future
releases.

Internal CMVC Defect 10962: R3Batch files are not installed on Windows XP

z/0S
APAR PQ75648: TWS engine does not handle status 2004 correctly.
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Installation

This section describes how to install IBM Tivoli Workload Scheduler for
Applications, Version 8.1.1 fix pack 3. This Fix pack upgrades all the extended
agents associated to the selected Tivoli Workload Scheduler for Application,
Version 8.1.1 instances. The R/3 feature distributed with this fix pack is the same
as the one present in fix pack 2. Fix packs are cumulative: so you can apply them
directly to the general availability version of the product without having to install
previous fix packs. Before you install the fix pack, ensure that the following
prerequisites are met:

+ Tivoli® Workload Scheduler processes are stopped.
* No extended agent method is running.

Hardware and software requirements
This section is divided into the following topics:

« |“Supported platforms’]

+ |“System requirements”

Supported platforms

Supported platforms at the time of the release are detailed in the IBM Tivoli

Workload Scheduler for Applications: Release Notes. For the most recent information,

consult the supported platforms matrix on the IBM® software support Web site:

http:/www.ibm.com/software/support

1. From the Web site, select Tivoli support from the Other support sites list.

2. When the page displays, select IBM Tivoli Workload Scheduler for
Applications from the Choose a product pull-down list.

3. Click the Supported Platforms in the Related Links section.

4. Click the Tivoli Platform and Database Support Matrix link

5. Enter your IBM registration ID and password.

System requirements

Hardware and software prerequisites are detailed in the IBM Tivoli Workload
Scheduler for Applications: Release Notes. There are currently no changes to the
information included in the Release Notes.

Applying the Fix Pack
This section provides information about applying the Fix Pack depending on the

environment you are working on. This section is divided into the following
sub-sections:

* |”Applying the Fix Pack in a UNIX Environment’]

* |“Applying the Fix Pack in a Windows NT /2000 Environment” on page 7|

“Applying the Fix Pack in a Mainframe Environment” on page §|

Note: Always verify that you have a viable backup before installing any software.

Applying the Fix Pack in a UNIX Environment
To apply the Fix Pack in a UNIX environment perform the following steps:

1. Set the limit of the Oracle Extended Agent Workstation(s), whose method you
want to uninstall, to 0.

2. Wait for the running Oracle Extended Agent Jobs to terminate, if any.

3. Move the following files into a backup directory:
¢ TWS_HOME/methods/MCMAGENT
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$MCM_TOP /bin/MCML]J
$MCM_TOP /bin/MCMT]
$MCM_TOP /bin/ MCMSTAT
$APPL_TOP/admin/MCMprod.txt

(being MCM_TOP=$APPL_TOP/mcm/integration)
The $APPL_TOP is a folder where the Oracle Application is installed.

Copy the ORACLE.TAR file from ORACLE_<platform> folder corresponding to
your platform into a tmp directory. Apply the installation steps as described in
the Installation Paragraph of Chapter one of the "IBM Tivoli Workload
Scheduler for Applications User’s Guide for Oracle E-Business Suite Access
Method Version 8.1.1.

4. For R3BATCH, follow the installation instructions described in the official
User's Guide.

5. For z/OS agent, remove the old installed files:

* Stop Tivoli Workload Scheduler on the local node where you are installing
the method.

* Log on as root, and change your directory to <TWSHOME>.

¢ Copy the MVS.TAR from MVS_<platform> folder corresponding to your
platform into <TWS_HOME> directory and run tar xvf MVS.TAR. For more
details see the Installation section in Chapter 1 of the IBM Tivoli Workload
Scheduler for Applications User’s Guide for z/OS Access Method, Version
8.1.1.

* Run customize as follows: /bin/sh customize -update -uname <twsuser>.
TWSUSER is the owner of the TWS installation.

Applying the Fix Pack in a Windows NT/2000 Environment
To apply the Fix Pack in a Windows NT/2000 environment perform the following
steps:

1. Uninstall any existing IBM Tivoli Workload Scheduler for Applications version
8.1.1 installation (R3BATCH and/or PSAGENT).

2. For R3BATCH, follow the installation instructions described in the official
User's Guide.

3. For PSAGENT, refer to the installation section in the IBM Tivoli Workload
Scheduler for Applications Version 8.1.1 User’s Guide.

4. For z/0OS agent, remove the old installed files:
* Stop Tivoli Workload Scheduler.
* Log on as a user in the local administrator group.
* Close any open Windows applications, including File Manager.
* Make a backup of the content of the methods directory.

 Extract the content of the MVS.zip archive into the Tivoli Workload
Scheduler home directory, overwriting the existing files and keeping the
directory structure.

¢ Run the Tivoli Workload Scheduler setup.exe program located in
<TWS_HOME>\setup:

* On the Account Information screen, enter the Tivoli Workload Scheduler user
and the password and click next.

* On the Setup Information screen verify the information you entered and click
next.

e Start Tivoli Workload Scheduler and resume scheduling activities.
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Applying the Fix Pack in a Mainframe Environment
To apply the Fix Pack in a Mainframe environment perform the following steps:

To install fix pack 3, download the LOADLIB_811_FP3 file contained in the ZOS
directory of the fix pack to the z/OS system according to the following
instructions:

1. From your TSO session emulator, select the ISPF command shell (TSO
command) and use the File Transfer utility (Send to Host) to transfer the
LOADLIB_811_FP3 library from the CD-Rom to the z/OS system, setting the
transfer for a logical record length of 80 and a fixed record format.

2. Receive the members in output datasets using the INDSN option. This will
unload 11 load modules into the output library. These load modules represent
the executable part of the product Tivoli Workload Scheduler for Applications
for z/OS Access Method on the mainframe side.

Notes for the User

This section contains new information and documentation corrections contained in
this fix pack. It is divided in the following sub-sections:

¢ |“PeopleSoft”

+ |[“Oracle Applications” on page 14
+ |“R/3” on page 14|

PeopleSoft
This Section contains information related to PeopleSoft. It is divided in the
following sub-sections:

+ |“Configuration”]

* |“Special Considerations and Known Limitations” on page 10|

* |“Troubleshooting” on page 11|

* |“Documentation Problems and Corrections” on page 18|

Configuration: The backend shipped with the new package invokes by default
the new Component Interface (CI) ITWS_PROCESSREQUEST. It is possible to force
the invocation of the original CI (or any compatible CI) by defining the following
new configuration options. A new configuration option may be used to invoke the
original component interface (PROCESSREQUEST). The new options are as
follows:

TWSXA_INLINE CI=<CI name>

TWSXA_SCHED_METH=<methname>
TWSXA_SKEDM_TYPE= [ i | f | b ]

Where:
<CI name>=Component Interface Name.

If this is not set the default value will be set as:
ITWS_PROCESSREQUEST<methname>=name of the PeopleSoft method invoked by the
Component Interface.

Make sure that the TWSXA_SCHED_METH method is used by the
TWSXA_INLINE_CI Component Interface (for example: ITWS_PROCESSREQUEST
uses Schedule).
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If you want to use the PeopleSoft component interface PROCESSREQUEST to
submit processes without in-line bind variables, you must set
TWSXA_INLINE_CI=PROCESSREQUEST.

TWSXA_SKEDM_TYPE is the return value type of the method: where (i= [integer],
f= [float],and b=[boolean]). The last option is used only for PeopleTools version
8.1x.

After installing the patch you must follow the steps as shown below:

1. A new PeopleSoft project called ITWS must be manually uploaded into the
PeopleSoft Database. Start the Application Designer and from the signon
window select to start the Application Designer in tier two mode as follows:

* Connection Type: <Database used> for example : Oracle
* Database Name: <Database Name>
* User ID: <operator PS> for example: PS
* Password of User ID
¢ The Application Designer starts.
2. Using the Application Designer:
* Copy Project from the file

* Using the browser, edit the full path to specify the folder where the project
that you want to load is located.

* The project is contained in the <TWSHOME>/methods/PeopleSoft/project-
version> subdirectories under the specific PeopleTools version directories,
where: project-version = PT844 | PT84x | PT81x.

 After you have chosen the folder of project, a list of projects appears in the
Project Name Field of the "Copy Project From File” window. Choose
ITWS_PSXA and click on the copy Button.

* A Copy "window” appears showing a list of Object Types.
* To set the new settings, click the "Options” button

* Click on "Report Filter” tab

* Click on "Select All” button

* Click on the "OK" button

* Click on "select All"

* Click on "Copy”, a copy progress bar appears. After loading the project, the
PeopleSoft Database contains the following objects:

* ITWS ProcessType Definition
e ITWS Permission List
e ITWSCls

3. To create the new Security Role ITWS_ROLE you can use the PeopleSoft Web
GUI or the Application Designer. Follow the steps below:

From the menu of the PeopleSoft Web GUIL:

¢ People tools -> Security -> Permission and Roles -> Roles

* From the Tabs select "Add a new value”

* Edit ITWS_ROLE in the Role Name Field

* Select the permission lists tab, select ITWS from the list, and Save.
From the Application Designer GUI:

* Using Maintain Security, edit the ITWS_ROLE window

* Select the Permissions list tab, select ITWS from the list, and save.
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To grant the ITWS_ROLE to all users who need to schedule jobs from Tivoli
Workload Scheduler, you can use the PeopleSoft Web GUI or the Application
Designer, following the steps below:

From the Application Designer GUI:

* Using Maintain Security, edit the user name.
* Select the Roles tab

¢ Add the ITWS_ROLE and Save.

From the PeopleSoft WEB GUI:

* People Tools -> Security -> User Profiles ->
* Edit the User Name

* Select the Roles Tab

¢ Add the ITWS_ROLE and Save

4. To add the ITWS process Types Definitions to the required Process Scheduler
you can use the PeopleSoft Web GUI or the Application Designer. Follow the
steps below: From the Application Designer GUI:

* Using Process Scheduler Manager

* Select the Server and add the ITWS_* Type definitions
* Process Type definitions

* Type definition

From the PeopleSoft WEB GUI:

* PeopleTools -> Process Scheduler -> Servers -> Search your server -> Add
the ITWS_*Process Types -> Save.

Note:

From the SQL interactive command line, the same task can be
performed by the following sample statement, customized for your
database environment:

INSERT INTO PS_SERVERCLASS SELECT 0.SERVERNAME,
0.0PSYS,'ITWS_" | 0.PRCSTYPE,0.PRCSPRIORITY, 0. MAXCONCURRENT
FROM PS_SERVERCLASS o WHERE ( SELECT count(*) FROM
PS_SERVERCLASS i WHERE i.SERVERNAME=0.SERVERNAME AND
i.OPSYS=0.0PSYS AND i.PRCSTYPE="TTWS_"| | 0.PRCSTYPE ) = 0

AND ( select count(*) from PS_PRCSTYPEDEEFN a where
a.PRCSTYPE="TTWS_’| 1 0.PRCSTYPE AND a.OPSYS=0.0PSYS ) > 0

5. Restart the process servers.

You do not need to make any changes to the existing Tivoli Workload
Scheduler job definitions, except for the scheduling nVision process, where the
runcontrol ID must be specified using the
<BUSINESS_UNIT>.<REPORT_ID>convention.

An example related to Job Definition for the scheduling nVision process is
shown below:

-process <process-name>-type nVision-Report -runcontrol
<BUSINESS_UNIT>.<REPORT_ID>

-process 'NVSRUN' -type nVision-Report -runcontrol AUSO1.VARIABLE

Special Considerations and Known Limitations: For PeopleTools version 8.4x,
three new keywords are recognized in the job definition to exploit a better output
of jobs running under the PeopleSoft Process scheduler. The new keywords are as
follows:
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* outputtype (accepts PeopleSoft keywords: that is FILE, WEB, EMAIL....)
* outputformat (accepts PeopleSoft keywords: that is PDF, HTML,....)

* outputdest (accepts PeopleSoft recognized destinations corresponding to the
output type)

No syntax check is performed on the values provided. If the values are not
recognized, defaults are used. During the Upload of the project a basic set of
Process Types starting with "ITWS_" are loaded (approximately 145 for PT84x and
PT844, approximately 96 for PT81x). If you submit a process with in-line bind
variables belonging to a Process Type <PT> that has no corresponding ITWS_
<PT>, then you should create it manually by using the PeopleSoft GUI.

Troubleshooting:
1. With PeopleTools Versions 8.x: CheckFile syntax is not supported.

2. With PeopleTools Versions 8.x: The -operator keyword is ignored: if you need
to use many different operator IDs, as a workaround, you can define multiple
XA workstations (one per OperatorID), and configure the options file with the
correct connection string.

3. No defect number: During method execution with PeopleTools version 8.41
servers, the following message may appear in the stdlist one or more times:
"PSProperties not yet initialized

java.lang.Throwable

at psft.pt8.util.PSProperties.getProperties(PSProperties.java:49)

at psft.pt8.definitions.LocalelOUtil.setLocale(LocalelOUtil.java:50)

at psft.pt8.net.LoginInfo.setLocaleObj(LoginInfo.java:258)

at psft.pt8.net.LoginInfo.setLocaleObj(LoginInfo.java:334)

at psft.pt8.net.LoginInfo.setLanguageCd(LoginInfo.java:249)

at psft.pt8.net.NetSession.deserializeUserContextDelta(NetSession.java:623)
at psft.pt8.net.CertificateService.deserializeReply(CertificateService.java:133)
at psft.pt8.net.NetService.requestService(NetService.java:147)

at psft.pt8.net.NetReqRepSvc.requestService(NetReqRepSvc.java:264)

at psft.pt8.net.NetSession.connect(NetSession.java:211)

at psft.pt8.net.NetSession.init(NetSession.java:125)

at psft.pt8.joa.Session.connectWithBlob(Session.java:232)

at psft.pt8.joa.Session.connect(Session.java:28)

at java.lang.reflect.Method.invoke(Native Method)

at psft.pt8.joa.JOAObject.invokeMethodHelper(JOAObject.java:137)

at psft.pt8.joa.JOAObject.invokeMethod(JOAObject.java:84)"

This is a minor problem that does not affect the regular running of the job. It
is also reported by PeopleSoft Support, but the resolution proposed is not
working for version 8.4x.

4. No defect number: During method execution with PeopleTools version 8.17.
There is a Date Format problem with the PeopleCode with versions of
PeopleTools earlier than 8.18. This is a known PeopleSoft issue which has been
referenced as the incident T-KRITZM-FR6JH "Component Interface
PROCESSREQUEST PeopleCode needs to be updated for 8.1X". For
PeopleTools versions before 8.18, you need to change the PeopleCode
manually.

5. If a job remains in INTRO state after you have submitted it you will see the
following message in the log:

Unable to set Processinstance to <xxx>
* TRC - Getting error message(s) from PSMessages:
e TRC - Number of Psoft Messages: 3
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* TRC - PeopleSoftMessage: Built-in function DatePart parameter 1 is invalid.
(2,195) At PRCSRQSTBC_WRK.REQUESTTYPE FieldFormula GetPrcsRgst
PCPC:6975 Statement:111’

¢ TRC - PeopleSoftMessage: 'Error changing value.
{PROCESSREQUEST.PROCESSINSTANCE]} (91,34)

* TRC - PeopleSoftMessage:'Failed to execute PSBusComp request’

6. The GetPrcsRqgst Function in the
PRCSRQSTBC_WRK.REQUESTTYPE.FieldFormula PeopleCode has to be
modified with these changes for the 8.1X codeline:

a. From your PeopleSoft Development Workstation open the "Application
Designer” application.

b. Select Insert, Objects into Project (or press the shortcut "Control-F7"). The
"Insert into Project” dialog appears. (Control-F7)

c. Open an Object Type of "Component Interfaces”.

d. In the Selection Criteria control group, in the"Name” input field, type
"PROCESSREQUEST” and press the ENTER key to select the records.

e. Click on the "Select All " button and then the "Insert” button.
f. Close the "Insert into Project” before continuing.

g. The PROCESSREQUEST Component Interface is shown in the tree view of
the Application Designer window. You may need to expand the
Component Interface folder to see it.

h. Double click on the PROCESSREQUEST (or right click and select "View
Definition”). You are shown the definition on the right window. Expand
the "Scroll - Level 0" item.

i. Right click on the "PRCSRQSTBC_WRK" record and select "View
Definition”

j. On the new window you see the record format of PRCSRQSTBC_WRK. Go
to the field named "REQUESTTYPE" (it should be in bold typeface). Right
click on it and select "View PeopleCode”.

k. The "PRCSRQSTBC_WRK. REQUESTTYPE.FieldFormula (Record
PeopleCode)” window is the active window on the right side of your
screen.

I. Select "Edit->Find" (or press Contol-F) to search on the PeopleCode for the
string "GetPrcsRgst”.

m. In the first lines of the PeopleCode Function "GetPrcsRqgst” there is an
SQLExec statement:

SQLExec ("SELECT A.RUNCNTLID, A.PRCSTYPE, A.PRCSNAME, A.PRCSJOBNAME, A.RUNLOCATION,
A.SERVERNAMERQST,

A.SERVERNAMERUN, A.RECURNAME, A.RUNDTTM, A.OUTDESTTYPE, A.OUTDESTFORMAT, B.OUTDEST,
A.RUNSTATUS,

C.XLATSHORTNAME FROM PSPRCSRQST A, PSPRCSPARMS B, XLATTABLE C, WHERE A.PRCSINSTANCE =
B.PRCSINSTANCE

AND A.PRCSINSTANCE = :1 AND C.FIELDNAME = 'RUNSTATUS' AND C.FIELDVALUE = A.RUNSTATUS
AND C.EFF_STATUS

= 'A'", &ProcessInstance, RUNCONTROLID, PRCSTYPE, PROCESSNAME, JOBNAME, &Runlocation,
&SERVERNAMERQST,

&SERVERNAMERUN, RUNRECURRANCE, &RUNDTTM, &OutDestType, &OutDestFormat, OUTDEST,
RUNSTATUS, RUNSTATUSDESCR)

n. You need to update it as shown in the following line:

SQLExec ("SELECT A.RUNCNTLID, A.PRCSTYPE, A.PRCSNAME, A.PRCSJOBNAME, A.RUNLOCATION,
A.SERVERNAMERQST, A.SERVERNAMERUN, A.RECURNAME,%DateTimeOut(A.RUNDTTM), A.OUTDESTTYPE,
A.OUTDESTFORMAT, B.OUTDEST,A.RUNSTATUS, C.XLATSHORTNAME FROM PSPRCSRQST A, PSPRCSPARMS
B, XLATTABLE C, PSOPTIONS D WHERE A.PRCSINSTANCE = B.PRCSINSTANCE AND A.PRCSINSTANCE

= :1AND C.FIELDNAME = 'RUNSTATUS' AND C.FIELDVALUE = A.RUNSTATUS AND C.EFF_STATUS
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= 'A' AND C.LANGUAGE_CD = D.LANGUAGE_CD", &ProcessInstance, RUNCONTROLID, PRCSTYPE,
PROCESSNAME, JOBNAME, &RunLocation, &SERVERNAMERQST, &SERVERNAMERUN, RUNRECURRANCE,
&RUNDTTM, &0utDestType, &OutDestFormat, OUTDEST, RUNSTATUS, RUNSTATUSDESCR);

Note: You are advised to duplicate the line before making the correction,
and then to comment out the original statement by using the block
comment characters "/*" <lines to comment> */)

0. Select "File->Save” (or Control-S) to save your changes.

p. Select "File->Exit" (or Control-Q) to close the Application Designer. If you
are prompted to save your project, select "No”".

7. When scheduling jobs to PeopleSoft version 8.20 after you have installed Ext
Api 8.20 on the Maestro system, if you follow the procedure: PeopleSoft
version 8.1x, an error occurs. The job shows that class
bea/jolt/JoltSessionAttributes are not found. This problem occurs because the
psjoa.jar is not available locally on the Fault-tolerant Agent where ExtApi 8.20
is installed. The original psjoa.jar is located on the PeopleSoft 8.20 System: The
path is as follows: %PS_HOME%\web\PSJOA.

To work around the problem you must follow the procedure below:

* Create a folder called "class” in <PS_Ext_Api_HOME> folder. For example,
if PeopleSoft ExtApi 8.20 Home is D:\PT820\bin\client\winx86_extapi,
then create the folder as follows: D:\PT820\bin\client\winx86_extapi\class
folder. Copy the psjoa.jar into the class folder.

Stop and restart the Tivoli Workload Scheduler services.

Note: CaselD 3179811 for PeopleSoft has been opened for this problem.

8. When loading the project on the PeopleSoft Application from the Application
Designer, a sequence of warning messages may appear as follows:

. e:\pt84310-retail\SRC\PSSYS\pjmupd.cpp
SQL error:Stmt#:425 Error Position: 12 Return:942-
ORA-00942 table or view does not exist

° SQL Access Manager

DELETE FROM PSPROJECTWORK WHERE

PROJECTNAME =:1
These popup messages are not error messages, they are only warnings. The
ITWS_PSXA is built on the PeopleSoft Dev Environment PT816 and PT841,
where the PSPROJECTWORK table exists. If the ITWS_PSXA project is loaded
on the PeopleSystem where the PSPROJECTWORK no longer exists, the above
popup sequence may appear, warning you that the PSPROJECTWORK table
does not exist. Click on the "OK” button, the project will continue loading.

9. When installing PeopleSoft 8.1.1, from the window where you specify the
PeopleTools Version and RunTime Environment, you have to start by selecting
"Back-end PeopleTools 8.1x or PeopleTools 8.4x" and continue the installation.
If you do not select "Back-end PeopleTools 8.1x or PeopleTools 8.4x" and
navigate between windows, when you select "Back-end PeopleTools 8.1x or
PeopleTools 8.4x" the installation process will not let you specify the Ext
Api8.x path. As a result you will be required to restart the installation. The
internal defect opened for this problem is d 11351 "Installation does not
require the correct back-end path version".

10. The joblog of a job submitted to PeopleSoft 8.4x shows the following message:
PeopleSoftMessage: 'Failed to execute PSBusComp request’ even if the job
ends successfully. This is only a warning message. The internal defect opened
for this problem is : d 11462 "Failed to execute PSBusComp request" message
always displayed.
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11. When submitting a job to PeopleSoft 8.1x the following message may be
shown: PeopleSoftMessage: "First operand of . is NULL, so cannot access
member Len. (2,236)". This is only a warning message, the execution will not
be affected. The internal defect opened for this problem is d 11463 "Error First
operand of . is NULL, so cannot access member Len".

Oracle Applications

Defect 13391: Fix has introduced this new behavior: Tivoli Workload Scheduler for
Applications Oracle Applications 8.1.1, allows you to submit a job to an Oracle
application in a three tier connectivity: In the three tier connection the user may
use two Oracle Server UNIX computers, the MCMAGENT will reside on a
computer where no APPS DB is present, (or is not used in the configuration file).
The DB is located in the second UNIX computer where it can be reached using
Oracle Network connectivity. The Oracle configuration file (version 8.1.1) has 13
options instead of 12, the 13th holds the Oracle name (tnsname) where the
connection is to be established. The new record format is: <CPU CPU Name><
Oracle_Home><Oracle_SID><Oracle Application Top Directory><FND Top
directory><PATH><Environment File To Execute><User Id><Password><Printer
Name><Min Time><Max Time>[<Oracle DB instance>] The Oracle DB instance
value is not mandatory, it is mandatory only for a 3/tier connectivity.

Example of a new mcmoptions file: "ORA_AIX_XA3T /oracle/DB/TST TST
/oracle/ Appsll $APPL_TOP/fnd/11.0.28 $PATH:$3FND_TOP /bin:$MCM_TOP /bin
$APPL_TOP/APPTST.env apps ##3Y-UGcZ-3Kap-6m prt4b2 1 5 TST".

Where TST is the name of the oracle DB instance where the APPS DB is located.
All other parameters are related to the local DB and APPS installation.

For the three tier configuration to work, you must define the TWO_TASK
environment variables inside the Oracle environment setup scripts. Remove its
definition when performing installation and re-link the steps. If you have set
TWO_TASK externally or in the scripts given to mcminstall as an input parameter,
you cannot perform the re-link steps successfully.

R/3
In R3BATCH 8.1.1 two important functions have been fixed : the BDC Wait option
and the "-client” command line flag.

1. Wait option with the "BDC wait” option, you can specify that an R/3 job
launched by IBM Tivoli Workload Scheduler is not to be considered complete
until all of its BDC sessions have completed. To make use of the option, an R/3
job must write informational messages in its joblog. This can be done by
adding a message statement either to the R/3 provided report BDCREXX
(BDCREX1) as described below, using the BDC session name (up to 12
characters), or the BDC queue ID (up to 20 characters).

Multiple messages can be written to allow monitoring of multiple BDC
sessions. Alternatively, if you do not want to make R/3 modifications, you can
also copy BDCRECXX to another name, for example ZBDCRECXX, make the
changes in the copy and include it in all the programs that generate BDC
sessions.

You have to do this manually for each job. If your BDC sessions are not created
using R/3 transaction SM35, but directly by a R/3 component, they may not
use the report BDCRECXX. In this case you can make modifications to the SAP
provided function module BDC_OPEN_GROUP as described below. Remember
that you should either modify the report BDCRECXX (or its copy
ZBDCRECXX) or the function module BDC_OPEN_GROUP.

14 1BM® Tivoli® Workload Scheduler for Applications: Readme File for Fix Pack 3 - PTF U499054



You must not modify both those objects.

Note: The completion status of a IBM Tivoli Workload Scheduler-launched R/3
job, whether SUCC or ABEND, is based entirely on the execution status
of the batch job. It is not related to the success or failure of any BDC
sessions, which are considered finished regardless of any errors found
during BDC processing.

* Using BDC Session Names. In order to use BDC session names, modify the
form open_group in the R/3 report BDCRECXX as follows:

— For SAP releases prior to 4.6¢c:

form open group.
if session = 'X'.
skip.
write: /(20) 'Create group'(i01), group.
skip.
* open batchinput group
call function 'BDC_OPEN_GROUP'
exporting client = sy-mandt
group = group
user = user
keep = keep
holddate = holddate.
message 1001(92) with group.
write: /(30) 'BDC_OPEN_GROUP'(i02), (12) 'returncode:'(i05), sy subrc.
endif.
endform.
— For SAP release 4.6¢ and later:
form open_group.
skip.
write: /(20) 'Create group'(i®l), group.
skip.
* open batchinput group
call function 'BDC_OPEN_GROUP'
exporting client = sy-mandt
group = group
user = user
keep = keep
holddate = holddate.
message 1001(92) with group.
write: /(30) 'BDC_OPEN_GROUP'(i02), (12) 'returncode:'(i05), sy subrc.
endform.
If BDC sessions are specified by name, IBM Tivoli Workload Scheduler
will not wait for the named BDC session to complete if there are other
BDC sessions of the same name that have completed.

Example:

An IBM Tivoli Workload Scheduler-launched R/3 job starts three BDC
sessions with the name ORD2, then issues one BDCWAIT message:
BDCWAIT:ORD2. After the first ORD2 session is complete, the status of the
R/3 job is shown as SUCC in IBM Tivoli Workload Scheduler. r3batch cannot
recognize non-unique BDCs (that is, named BDCs).

Another problem of using BDC sessions with names is with different system
times in a distributed R/3 environment. R3batch scans for BDC sessions with
the specified names which are generated during the runtime of the creator
job. If the creator job does nothing other than start BDC sessions, the runtime
might be very short. If no time synchronization is installed, the system time
of different machines usually differs in a distributed R/3 environment. This
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time difference might be larger than the job runtime. It is therefore possible
that the wrong time interval is scanned and the BDC sessions are never
detected.

Therefore it is strongly recommended to use the BDC queue ID method
described below.

* Using BDC Session Queue ID with Report BDCRECXX. In addition to the
above description, BDC sessions can also be specified by queueid, the
20-digit BDC session identifier. Because each queueid assigned by R/3 is
unique, one BDCWAIT message must be issued for each separate queueid to

be monitored. To determine the queueid, modify the form open_group in the
R/3 report BDCRECXX as follows:

— For SAP releases prior to 4.6¢c:

form open_group.
if session = 'X'.
skip.
write: /(20) 'Create group'(i0l), group.
skip.
* open batchinput group
call function 'BDC_OPEN_GROUP'
exporting client = sy-mandt
group = group
user = user
keep = keep
holddate = holddate
importing qid = myquid.
message 1001(92) with myqid.
write: /(30) 'BDC_OPEN_GROUP'(i02), (12) 'returncode:'(i05), sy subrc.
endif.
endform.

— For SAP release 4.6¢ and later:

form open_group.
skip.
write: /(20) 'Create group'(i01), group.
skip.
* open batchinput group
call function 'BDC_OPEN_GROUP'
exporting client = sy-mandt
group = group
user = user
keep = keep
holddate = holddate
importing qid = myquid.
message 1001(92) with myqid.
write: /(30) 'BDC_OPEN_GROUP'(i02), (12) 'returncode:'(i05), sy_subrc.
endform.

Do not forget to define the variable myqid in BDCRECXX. With this
approach, you have a global change in your R/3 system.

* Using BDC queue ID with FM BDC_OPEN_GROUP BDC, sessions which
have not been created by the R/3 transaction SM35, but by a R/3
component, may not use the report BDCREXX. In this case the best solution
to track these BDC sessions is to modify the R/3 function module
BDC_OPEN_GROUP as follows:

FUNCTION BDC_OPEN_GROUP.

CALL 'BDC_OPEN_GROUP' ID 'CLIENT' FIELD CLIENT
ID 'GROUP' FIELD GROUP
ID 'USER' FIELD USER
ID 'KEEP' FIELD KEEP
ID '"HOLDDATE' FIELD HOLDDATE
ID 'DESTINATION' FIELD DEST
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ID 'QID' FIELD QID
ID 'RECORD' FIELD RECORD
ID 'PROG' FIELD PROG.

*

IF SY-SUBRC EQ 0.
BQID = QID. " bqgid wird beim close gebraucht
BUSER = SY-MSGV1.
BGROUP = GROUP .
% CALL FUNCTION 'DB_COMMIT'.
CALL FUNCTION 'ENQUEUE_BDC QID'
EXPORTING DATATYP = 'BDC '
GROUPID = BGROUP

QID = BQID

EXCEPTIONS FOREIGN_LOCK = 98

SYSTEM_FAILURE = 99.

IF SY-SUBRC EQ 0.

message 1001(92) with qid.

ENDIF.

ENDIF.

*

PERFORM FEHLER_BEHANDLUNG USING SY-SUBRC.

*
*

ENDFUNCTION.

Note: Note that the actual parameters of the C function call (CALL
"BDC_OPEN_GROUP’ ID ...) may vary depending on the R/3 release
number. With this approach, you have a global change in your R/3
system.

2. "-client” Command Line Option

When R3BATCH is invoked, it reads configuration information from an option
file such as the R/3 host, the R/3 RFC used, and so on. It receives information
about the R/3 job to run from the IBM Tivoli Workload Scheduler.

A Tivoli Workload Scheduler job could point to a R/3 job by specifying its job
name (with the "-job” option) and job ID (with the "-i" option) or jobname and
user name (with the "-user” option) which it belongs to. Once R3BATCH has
collected the whole set of information it connects to the R/3 system and makes
a copy of the selected job (which is actually a "template” job) and marks it in
the R/3 as able to run and sets its start time to "start immediate”.

The copied job belongs to the RFC user used by R3BATCH to establish the
connection and it runs on the R/3 client specified in the option file. By using
the "-client” command line option it was possible to use a different client from
the one specified in the option file. This option was incomplete, because there
is an ambiguity between the client used to find the job to run and the client
when the selected job should be actually run. With the current R3BATCH it is
possible to use the following command line options:

-client instructs R3BATCH to find a job definition in a specific R/3 client
-exec_client instructs R3BATCH to run a job in a specific R/3 client. For
example, the following Tivoli Workload Scheduler job definition copies the
MYUSER’s MYJOBI1 job (defined in the client 555) into the client 888, even if
the default client (defined in the options file) is 000:
MYR3CPU#MYTWSJOB
SCRIPTNAME "/ -job MYJOB1 -user MYUSER -client 555 -exec_client 888"
STREAMLOGON "mytwsuser"

DESCRIPTION "*
RECOVERY STOP

Note: The picklist function (provided by the JSC) still displays all the jobs
defined in the default client.
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As default, the JSC saves R/3 related jobs with the R/3 job name and R/3 job
ID. For example, once the job MYJOB2 (with id 12345678) has been selected on
the picklist panel, the Tivoli Workload Scheduler job in the Tivoli Workload
Scheduler database looks like this:
MYR3CPU#MYTWSJOB

SCRIPTNAME "/ -job MYJOB -i 12345678"

STREAMLOGON "mytwsuser"

DESCRIPTION ""
RECOVERY STOP

To customize this definition you can:
1. Modify the job definition using the Tivoli Workload Scheduler composer utility,

2. Remove the "JobDef=R3BATCH" line in the r3batch.opts file and access the job
definition using the JSC as for any other extended agent access method. In this
way all the R/3 specific panels are no longer displayed until the
"JobDef=R3BATCH" line is inserted again in r3batch.opts.

With APAR 1Y39442 fix, the user can define a new JOB SAP, connecting to a
Japanese system, specifying Ext.program type JOB. The JOB name is upper cased
correctly and it is kicked off.

Documentation Problems and Corrections

This section contains new information and documentation problems corrections
contained in this fix pack. It is divided in the following sub-sections:

¢ |“PeopleSoft”

+ |“2/0S” on page 19|

PeopleSoft

APAR 1Y58262: Before installing this fix pack, the existing PeopleSoft method must
be uninstalled. This fix pack installs the PeopleSoft project directories related to
PeopleTools Versions 8.1x and 8.4x, as shown in the following structure:

TWS_HOME\methods\
\---PeopleSoft
\---PT81x

\---ITWS_PSXA
BCM.DAT
BCM.KEY
CLM.DAT
CLM.KEY
ITWS_PSXA.ini
MSG.DAT
MSG.KEY
PCM.DAT
PCM.KEY
PJIM.DAT
PJM.KEY
SMDL.DAT
SMDL.KEY

\---PT84x

\---ITWS_PSXA
TTWS_PSXA.ini
ITWS_PSXA. XML

\---PT844
\---ITWS_PSXA
ITWS_PSXA.ini
ITWS_PSXA. XML
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The PeopleSoft project in PT81x directory applies to PeopleSoft Version 8.1x, the
project in PT84x directory applies to PeopleSoft Version 8.4x with x up to 3 and the
project in PT844 directory applies to PeopleSoft Version 8.44.

z/0S
Doc changes introduced for APAR PQ77450: Manual SH19-8504-01 "User’s Guide
for z/OS Access Method” Version 8.1.1 Maintenance Release November 2003.

At page 27 add, at the bottom of the messages: "TSI031E TASK task MODULE
module LAUNCH OF JOB “jobname” FAILED”

Doc changes introduced for APAR PQ95242: Manual SH19-8504-01 "User’s Guide
for z/OS Access Method” Version 8.1.1 Maintenance Release November 2003.

At page 6, after CA7USER, add a new variable CA7WAIT(0) with the following
description: "The amount of time, in hundredths of a second, that each Gateway
task has to wait, after that CA-7 has sent to the console the answer which confirms
that the Gateway request to LOGON to it has been successfully processed, before
issuing the next command to CA-7 itself. The default is 0, which means that no
wait will happen. The maximum value must be in any case lower than half of the
value specified by MAXWAIT. Change only in coordination with IBM Technical
support.” At page 27 add, at the bottom of the messages: "TSI039E CA7WAIT
MUST BE LOWER THAN HALF OF MAXWAIT”
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Chapter 2. Contacting IBM Software Support

Before contacting IBM Software Support with a problem, refer to the IBM Software
Support site by accessing the following Web address:

lhttp:/ /www.ibm.com /software /support|

To access Tivoli support, click the Tivoli support link at the bottom right of the
page.

If you want to contact IBM Software Support, see the IBM Software Support Guide at
the following Web site:

lhttp:/ /techsupport.services.ibm.com/ guides/handbook.html|

The guide provides information about how to contact IBM Software Support,
depending on the severity of your problem, and the following information:

* Registration and eligibility.
* Telephone numbers, depending on the country in which you are located.
* Information you must have before contacting IBM Software Support.
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Chapter 3. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road

Austin, TX 78758 US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information in softcopy form, the photographs and color
illustrations might not display.

Trademarks

IBM, the IBM logo, AIX®, Tivoli, the Tivoli logo, and z/OS are trademarks or
registered trademarks of International Business Machines Corporation in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT are registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries
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Java " and all Java-based trademarks and logos are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United
States, other countries, or both.

Linux' is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product, and service names may be trademarks or service marks
of others.
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